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Copyright and Disclaimer
Product specifications are subject to change without notice and do not represent a commitment on the part of 
Avid Technology, Inc.

The software described in this document is furnished under a license agreement. You can obtain a copy of that license by 
visiting Avid's Web site at www.avid.com. The terms of that license are also available in the product in the same directory as 
the software. The software may not be reverse assembled and may be used or copied only in accordance with the terms of the 
license agreement. It is against the law to copy the software on any medium except as specifically allowed in the license 
agreement.

Avid products or portions thereof are protected by one or more of the following United States Patents: 4,746,994; 4,970,663; 
5,045,940; 5,267,351; 5,309,528; 5,355,450; 5,396,594; 5,440,348; 5,452,378; 5,467,288; 5,513,375; 5,528,310; 5,557,423; 
5,577,190; 5,584,006; 5,640,601; 5,644,364; 5,654,737; 5,715,018; 5,724,605; 5,726,717; 5,729,673; 5,745,637; 5,752,029; 
5,754,851; 5,799,150; 5,812,216; 5,828,678; 5,842,014; 5,852,435; 5,987,501; 6,061,758; 6,223,211; 6,301,105; 6,532,043; 
6,546,190; 6,636,869; 6,747,705, 6,763,523; 6,813,622. Other patents are pending.

This document is protected under copyright law. An authorized licensee of Avid DNxchange may reproduce this publication for 
the licensee’s own use in learning how to use the software. This document may not be reproduced or distributed, in whole or in 
part, for commercial purposes, such as selling copies of this document or providing support or educational services to others. 
This document is supplied as a guide for Avid DNxchange. Reasonable care has been taken in preparing the information it 
contains. However, this document may contain omissions, technical inaccuracies, or typographical errors. Avid Technology, 
Inc. does not accept responsibility of any kind for customers’ losses due to the use of this document. Product specifications 
are subject to change without notice.

Copyright © 2006 Avid Technology, Inc. and its licensors. All rights reserved. 

The following disclaimer is required by Sam Leffler and Silicon Graphics, Inc. for the use of their TIFF library:
Copyright © 1988–1997 Sam Leffler 
Copyright © 1991–1997 Silicon Graphics, Inc.

Permission to use, copy, modify, distribute, and sell this software [i.e., the TIFF library] and its documentation for any purpose 
is hereby granted without fee, provided that (i) the above copyright notices and this permission notice appear in all copies of 
the software and related documentation, and (ii) the names of Sam Leffler and Silicon Graphics may not be used in any 
advertising or publicity relating to the software without the specific, prior written permission of Sam Leffler and Silicon 
Graphics.

THE SOFTWARE IS PROVIDED “AS-IS” AND WITHOUT WARRANTY OF ANY KIND, EXPRESS, IMPLIED OR 
OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A 
PARTICULAR PURPOSE.

IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT 
OR CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, 
DATA OR PROFITS, WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF 
LIABILITY, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

The following disclaimer is required by the Independent JPEG Group:
Portions of this software are based on work of the Independent JPEG Group.

The following disclaimer is required by Paradigm Matrix:
Portions of this software licensed from Paradigm Matrix.

The following disclaimer is required by Ray Sauers Associates, Inc.:
“Install-It” is licensed from Ray Sauers Associates, Inc. End-User is prohibited from taking any action to derive a source code 
equivalent of “Install-It,” including by reverse assembly or reverse compilation, Ray Sauers Associates, Inc. shall in no event be 
liable for any damages resulting from reseller’s failure to perform reseller’s obligation; or any damages arising from use or 
operation of reseller’s products or the software; or any other damages, including but not limited to, incidental, direct, indirect, 
special or consequential Damages including lost profits, or damages resulting from loss of use or inability to use reseller’s 
products or the software for any reason including copyright or patent infringement, or lost data, even if Ray Sauers Associates 
has been advised, knew or should have known of the possibility of such damages.

The following disclaimer is required by Videomedia, Inc.:
“Videomedia, Inc. makes no warranties whatsoever, either express or implied, regarding this product, including warranties with 
respect to its merchantability or its fitness for any particular purpose.”

“This software contains V-LAN ver. 3.0 Command Protocols which communicate with V-LAN ver. 3.0 products developed by 
Videomedia, Inc. and V-LAN ver. 3.0 compatible products developed by third parties under license from Videomedia, Inc. Use 
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of this software will allow “frame accurate” editing control of applicable videotape recorder decks, videodisc recorders/players 
and the like.” 

The following disclaimer is required by Altura Software, Inc. for the use of its Mac2Win software and Sample 
Source Code:
©1993–1998 Altura Software, Inc.

The following disclaimer is required by 3Prong.com Inc.:
Certain waveform and vector monitoring capabilities are provided under a license from 3Prong.com Inc.

Attn. Government User(s). Restricted Rights Legend
U.S. GOVERNMENT RESTRICTED RIGHTS. This Software and its documentation are “commercial computer software” or 
“commercial computer software documentation.” In the event that such Software or documentation is acquired by or on behalf 
of a unit or agency of the U.S. Government, all rights with respect to this Software and documentation are subject to the terms 
of the License Agreement, pursuant to FAR §12.212(a) and/or DFARS §227.7202-1(a), as applicable.

Trademarks
888 I/O, Adrenaline, AirPlay, AirSPACE, AirSPACE HD, AirSpeed, AniMatte, AudioSuite, AudioVision, AutoSync, Avid, 
Avid DNA, Avid DNxcel, Avid DNxHD, AVIDdrive, AVIDdrive Towers, Avid Learning Excellerator, Avid Mojo, AvidNet, 
AvidNetwork, AVIDstripe, Avid Unity, Avid Unity ISIS, Avid Xpress, AVoption, AVX, CamCutter, ChromaCurve, ChromaWheel, 
DAE, D-Fi, D-fx, DigiDelivery, Digidesign, Digidesign Audio Engine, Digidesign Intelligent Noise Reduction, DigiDrive, 
Digital Nonlinear Accelerator, DigiTranslator, DINR, DNxchange, D-Verb, Equinox, ExpertRender, FieldPak, Film Composer, 
FilmScribe, FluidMotion, HIIP, HyperSPACE, HyperSPACE HDCAM, IllusionFX, Image Independence, iNEWS, 
iNEWS ControlAir, Instinct, Intraframe, iS9, iS18, iS23, iS36, LaunchPad, Lo-Fi, Magic Mask, make manage move | media, 
Marquee, Matador, Maxim, MCXpress, Media Browse, Media Composer, MediaDock, MediaDock Shuttle, Media Fusion, 
Media Illusion, MediaLog, Media Reader, Media Recorder, MEDIArray, MediaShare, Meridien, MetaSync, MissionControl, 
NaturalMatch, Nearchive, NetReview, NewsCutter, Nitris, OMF, OMF Interchange, OMM, Open Media Framework, 
Open Media Management, ProEncode, Pro Tools, QuietDrive, Recti-Fi, RetroLoop, rS9, rS18, Sci-Fi, Softimage, 
Sound Designer II, SPACE, SPACEShift, SpectraGraph, SpectraMatte, Symphony, Trilligent, UnityRAID, Vari-Fi, 
Video Slave Driver, VideoSPACE, and Xdeck are either registered trademarks or trademarks of Avid Technology, Inc. in the 
United States and/or other countries.

iNEWS, iNEWS ControlAir, and Media Browse are either registered trademarks or trademarks of iNews, LLC.

Windows is a registered trademark or trademark of Microsoft Corporation in the United States and/or other countries. All other 
trademarks contained herein are the property of their respective owners.

GOT FOOTAGE?

Editors — Filmmakers — Special Effects Artists — Game Developers — Animators — Educators — Broadcasters — Content 
creators of every genre — Just finished an incredible project and want to share it with the world?

Send us your reels and we may use your footage in our show reel or demo!*

For a copy of our release and Avid’s mailing address, go to www.avid.com/footage.

*Note: Avid cannot guarantee the use of materials submitted.

Avid DNxchange Installation and User’s Guide • 0130-07442-01 Rev. A• February 2006

http://www.avid.com/footage
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Using This Guide

Congratulations on your purchase of an Avid® DNxchange™ transcoder interface. This 
document describes how to work with high-definition media in a standard-definition 
environment.

Symbols and Conventions

Avid documentation uses the following symbols and conventions:

Symbol or Convention Meaning or Action

n A note provides important related information, reminders, 
recommendations, and strong suggestions.

c A caution means that a specific action you take could cause harm to 
your computer or cause you to lose data.

w A warning describes an action that could cause you physical harm. 
Follow the guidelines in this document or on the unit itself when 
handling electrical equipment.

> This symbol indicates menu commands (and subcommands) in the 
order you select them. For example, File > Import means to open the 
File menu and then select the Import command.

t This symbol indicates a single-step procedure. Multiple arrows in a 
list indicate that you perform one of the actions listed.

Italic font Italic font is used to emphasize certain words and to indicate variables.

Courier Bold font Courier Bold font identifies text that you type.

Ctrl+key or mouse action Press and hold the first key while you press the last key or perform the 
mouse action. For example, Ctrl+drag.
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If You Need Help

If you are having trouble using DNxchange:

1. Retry the action, carefully following the instructions given for that task in this guide. It 
is especially important to check each step of your workflow.

2. Check for the latest information that might have become available after the 
documentation was published:

- If the latest information for your Avid product is provided as printed release notes, 
they ship with your application and are also available online.

- If the latest information for your Avid product is provided as a ReadMe file, it is 
supplied in your Avid application folder as a PDF document (ReadMe.pdf) and is 
also available online.

You should always check online for the most up-to-date release notes or ReadMe 
because the online version is updated whenever new information becomes 
available. To view these online versions, select ReadMe from the Help menu. or visit 
the Knowledge Base at www.avid.com/readme.

3. Check the documentation that came with your Avid application or your hardware for 
maintenance or hardware-related issues.

4. Visit the online Knowledge Base at www.avid.com/onlinesupport. Online services are 
available 24 hours per day, 7 days per week. Search this online Knowledge Base to find 
answers, to view error messages, to access troubleshooting tips, to download updates, 
and to read or join online message-board discussions.

How to Order Documentation

To order additional copies of this documentation from within the United States, call Avid 
Sales at 800-949-AVID (800-949-2843). If you are placing an order from outside the 
United States, contact your local Avid representative.

Avid Educational Services

For information on courses/schedules, training centers, certifications, courseware, and 
books, please visit www.avid.com/training or call Avid Sales at 800-949-AVID (800-949-
2843).

http://www.avid.com/readme 
http://www.avid.com/onlinesupport
http://www.avid.com/training


Chapter 1

Design Overview

This chapter provides background information about the DNxchange transcoder interface. 
The Avid DNxchange converts high definition (HD) media from HD-SDI devices to Avid 
DNxHD media encoded in a Serial Digital Transport Interface (SDTI) stream. The Avid 
DNxchange also transports of 8 channels of embedded audio, longitudinal timecode (LTC), 
and other ancillary data embedded in the HD SDI input stream. This device enables you to 
move HD media through your existing standard-definition (SD) serial digital interface (SDI) 
networks. This enables you to transport high quality HD compressed media greater distances 
than with HD-SDI.

The following topics are discussed:

• Overview

• Channel Inputs and Outputs

• Reference Signal

• Monitoring HD Video During Capture

• Network Connection

• Serial Connection

Overview

The Avid DNxchange is a rack-mounted I/O device which can be populated with two 
transcoder channels. Each DNxchange channel can be configured as either an HD-to-SD 
transcoder (compression/capture) or as an SD-to-HD transcoder (decompression/play).

A typical application for the DNxchange is to transport HD media over long distances. A 
deck could physically be located in one room while you are monitoring the HD video on a 
monitor down the hall. If the distance is greater than what is supported by an HD coax 
transport solution, the data can be transformed to a lower bit rate using the DNxchange. The 
DNxchange lowers the bit rate by compressing the data and then transporting the data over 
an SD-SDI infrastructure to the monitor. Very little quality is lost because of the DNxHD 
compression and the DNxchange SD SDI supports a distance up to 280 meters.
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Typical End-to-End DNxchange Transport Application

This illustration shows the DNxchange capturing an HD serial bit stream and converting it to 
compressed DNxHD data. Concurrent with the compression operation, up to 8 audio 
channels and other ancillary data are separated. The audio, ancillary, and the DNxHD data 
are subsequently rejoined for transport over a SD SDTI serial bit stream. The compression 
ratio is fixed at approximately 6:1 for all formats.

In Play mode the DNxchange accepts this standard SD SDTI serial bit stream and 
decompresses it back to HD data for transmission over an HD serial bit stream. 

Channel Inputs and Outputs

The DNxchange is available in either a single-channel or dual-channel model. Each channel 
can be configured to transcode HD to SD or SD to HD. If you have purchased a single 
channel DNxchange, you can purchase a second channel and install it as described in 
“Installing the Optional Second DNxchange Channel” on page 51.

HD data captured by the DNxchange channel is output through the SD SDI output connector 
as a 525-line or 625-line SDTI signal. The HD SDI output can be used to monitor the HD 
video while it is being captured. 

aa

Initial Ethernet or serial connection 
used to configure the DNxchange

DNxchange channel in 
decompression/Play mode

HD deckHD deck

HD monitor

DNxchange channel in 
compression/Capture mode

SD SDTISD SDTI

HD SDI

HD SDI

Reference 
signal

SD SDTI video router
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To recover the HD SDI signal, connect the SDTI signal to the SD SDI input connector on a 
second DNxchange channel, and set the channel to Play mode. 

DNxchange supports the following embedded signals:

• video

• 48kHz 24-bit embedded audio

• vertical interval timecode (VITC) or LTC

• closed caption

The following figure shows the minimum connections required for each channel when in 
Capture mode and Play mode.

Capture and Play Channels Requirements

One power supply is used to power both DNxchange channels. The DNxchange channel 
closest to the power supply bridges the power to the optional second DNxchange channel.

OUT

LTC

OUT

IN

OUT

IN

OUT

IN

OUT

IN

Play mode

Capture mode

HD IN

HD OUT

Reference
SD IN

Reference

SD OUT

Power supply
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Capture Mode

In compression/capture mode the DNxchange accepts a standard HD-SDI (SMPTE 292M) 
serial bit stream and converts the video, embedded audio, and other ancillary data into a 
compressed data stream for transport over a standard SD SMPTE 259M serial bit stream. 
The DNxHD compressed data uses an SDTI format for synchronous, real-time transfers of 
HD data using an existing SD SDI network. 

If an LTC signal is connected to the LTC input, it is also captured in Capture mode. The 
different data types are processed separately and recombined using delays to compensate for 
the processing and sent out the SD-SDTI output. The total delay through the channel is 6 
frames.

Play Mode

In decompression/play mode the DNxchange accepts a standard SD SMPTE 259M serial bit 
stream and converts it into an HD stream for transmission over an HD SMPTE 292M serial 
bit stream. 

The SD SDTI data received is separated into the various data types. Video data is sent to the 
codec to be decompressed and subsequently all the data types are recombined with the 
correct latency. The total delay through the channel is 6 frames. 

Embedded Audio Support

Eight channels of 48 kHz SMPTE 299M embedded audio is extracted from the HD SDI 
input buffered and delayed by the same frame delay as the DNxHD codec and re-inserted on 
the SD SDI output and locked with the DNxHD compressed data stream in accordance with 
SMPTE 272M.

LTC In/LTC Out

When the DNxchange channel is in Capture mode and a longitudinal timecode (LTC) signal 
is connected to the LTC input, the LTC is auto-detected and the timecode is embedded into 
the SDTI SD stream with the encoded HD media. The LTC is delayed to match the same 
frame delay as the DNxHD codec output. 

This embedded timecode from the DNxchange is used by the AirSpeed when the AirSpeed 
is in HD mode, even if a separate LTC is connected directly to the AirSpeed. When 
AirSpeed is in SD mode, the LTC port on AirSpeed is active timecode.

VITC and Closed Caption

VITC and closed caption information are preserved with the media within the device while 
capturing and playing out. 
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Supported Media Formats

The following is a list of supported HD formats:

• 1080 Interlaced

- 1080i/59.94 fields per second 

- 1080i/50 fields per second 

• 720 Progressive

- 720p/59.94 frames per second 

Reference Signal

All the components that make up the end-to-end infrastructure solution when using the 
DNxchange must have a reference connected to their respective reference inputs. The 
reference signal can either be a black-burst or tri-level reference signal. The HD data source 
connected to the DNxchange, the DNxchange channel capturing media, and the DNxchange 
channel playing the DNxHD data must all use reference that are phase-locked to each other.

Each channel in a DNxchange enclosure must have a separate reference signal connected to 
the REF input connector regardless of the mode in which the channel is configured. Avoid 
looping the reference signal and terminate any unused loop out with a 75 ohm terminator.

Reference Connections

OUTLTCINOUTINOUTINOUTINOUTIN OUTINREF REF

SERIAL

10/100 BASE T 10/100 BASE TLTC

SERIAL

HDSDHD SD

HD SDI and SD SDTI 
devices

Reference 
signal

DNxchange channelDNxchange channel
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Monitoring HD Video During Capture

When capturing HD media you can monitor the captured HD media at the following two 
locations:

• The easiest way to view the HD media coming into the DNxchange is to connect an HD 
monitor to the HD Out connector on the same DNxchange channel that is doing the 
capturing. As the media is being captured through the HD In connector, the video 
(without audio and ancillary data) is looped back through to the HD Out connector. 

• If you would rather see that the encoded HD media in the SD SDTI stream is being 
captured accurately, connect the SD SDTI Out on your video router to the SD In 
connector on a second DNxchange channel that is configured for Play mode. This 
output stream includes the video, embedded audio, and ancillary data.

n You must provide a reference signal to both DNxchange channels and make sure the 
appropriate channels are configured for capturing or playing out.

Connect an HD monitor to the HD Out connector on the DNxchange play channel. The 
HD output of the second channel lags behind the HD input of the first channel by several 
frames. 

Network Connection

A 10/100BASE-T Ethernet port is provided on each DNxchange channel for configuring 
that channel. Each DNxchange channel in the DNxchange enclosure needs a unique name 
and IP address. Configuring the DNxchange through the Ethernet port is done with a 
browser application. For information on configuring DNxchange channels through the 
network, see “User Configuration Windows” on page 36.

Serial Connection

For flexibility, the DNxchange supports more than one configuration and setup mechanism. 
You can also configure each DNxchange channel in the DNxchange through its 9-pin 
RS-232 interface connector on the rear of the DNxchange. For information on configuring 
DNxchange channels through a serial connection, see “Accessing the DNxchange Through 
HyperTerminal” on page 43.



Chapter 2

Installation

This chapter provides DNxchange installation, connection, and system configuration 
instructions. 

n You might want to configure the DNxchange prior to rack mounting if the front panel access 
is limited in your rack location.

c Do not connect multiple DNxchange channels to your network environment until you 
have assigned a new unique IP address to each DNxchange channel. 

Using the DNxchange on the Desktop

If you do not intend on rack-mounting the DNxchange, Avid includes four adhesive rubber 
feet that attach to the bottom of the chassis. 

To use the DNxchange on a desktop: 

1. Locate the four adhesive rubber feet included with the DNxchange.

2. Attach the rubber bumpers so that it adheres to each location marked on the bottom of 
the DNxchange chassis.

Installing DNxchange in a Rack 

The DNxchange is designed for 19-inch (483-mm) rack enclosures and requires one EIA 
rack unit (1U), or 1 ¾ inches (44.5 mm) of rack space. The DNxchange ships with rack-nut 
clips for those rack enclosures that do not have threaded holes. Position the rack-nut clips in 
the holes of the rack used to secure the rack DNxchange in place. 

w To ensure the stability of the rack enclosure, start from the bottom when you install the 
rack components in the rack enclosure.
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The rack-mount requirements are: 

• Elevated Operating Ambient — If installed in a closed or multi-unit rack assembly, 
the operating ambient temperature of the rack environment might be greater than room 
ambient. Therefore, consideration should be given to installing the equipment in an 
environment compatible with the maximum ambient temperature (Tma) specified by the 
manufacturer.

• Reduced Air Flow — Installation of the equipment in a rack should be such that the 
amount of air flow required for safe operation of the equipment is not compromised.

DNxchange airflow is from the front of the chassis enclosure to the rear. Make 
allowances for cooling air to be available to the front panel surface and without anything 
restricting the airflow in the rear.

• Mechanical Loading — Mounting of the equipment in the rack should be such that a 
hazardous condition is not achieved due to uneven mechanical loading.

Make sure your rack enclosure is stable enough to prevent a ti-over hazard when one or 
more DNxchange systems are extended on the sliding rails.

• Circuit Overloading — Consideration should be given to the connection of the 
equipment to the supply circuit and the effect that overloading of the circuits might have 
on overcurrent protection and supply wiring. Appropriate consideration of equipment 
nameplate ratings should be used when addressing this concern.

• Reliable Earthing — Reliable earthing of rack-mounted equipment should be 
maintained. Particular attention should be given to supply connections other than direct 
connections to the branch circuit (for example, use of power strips).

Attaching the Rack-Nut Clips to the Rack

Install the rack-nut clips where the DNxchange front panel will secure to the rack enclosure.
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To attach the rack-nut clips to the rack enclosure:

1. Select the lowest position in the rack where you can mount the DNxchange. Position the 
DNxchange so the bottom is at the baseline of a U-alignment position. 

Positioning the Avid DNxchange

2. From the inside of the mounting rail, slide a rack-nut clip over each of the eight holes to 
be used for the DNxchange. 

Attaching Rack-Nut Clips onto the Rack Mounting Rail

5/8 in

5/8 in

1/2 in

5/8 in

5/8 in

1/2 in

5/8 in

5/8 in

1/2 in

5/8 in

5/8 in

1/2 in

1U

2U

3U1 3/4 in

1 3/4 in

1 3/4 in
Baseline position is between 
two 1/2-inch holes.

Rack mounting rail 
hole spacing

EIA rack unit

Rack mounting rail

DNxchange bezel 
mounting holes

Rack-nut clip slid 
over hole

Rack enclosure
mounting rail

Use your own rack hardware if 
your rack has threaded holes or 
unique fasteners.
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Attaching the Brackets to the DNxchange

You must position the two mounting brackets on the DNxchange before placing the 
DNxchange in the rack. Both mounting brackets are identical and can be attached to either 
side of the DNxchange. The brackets that attach to the DNxchange can adjust from 23.5 
inches (597 mm) to 30 inches (762 mm).

To attach the mounting brackets:

1. Align the slotted holes in the mounting bracket with the shoulder screws that are on the 
sides of the DNxchange. Make sure the bend in the bracket is toward the inside with the 
mounting-bracket ear facing outward. 

2. Insert the two shoulder screws through the enlarged holes in the mounting bracket. 

Attaching the Brackets to the DNxchange

3. Slide the mounting bracket a couple of inches down the slot to hold the bracket in place. 

The shoulder screws do not tighten to the mounting brackets. They allow the mounting 
bracket to slide to the rear rack rails. 

4. Repeat this procedure for attaching the second bracket on the other side of the 
DNxchange.

Securing the DNxchange in a Rack

c To Avoid injury, you should have someone help you lift the DNxchange while you are 
positioning it into the rack.

a

Mounting bracket 
ear facing outward

Enlarged hole

Mounting bracket with 
bend toward the inside

Shoulder screw



Installing DNxchange in a Rack

21

To secure the DNxchange to the rack enclosure:

1. From the front of the rack, slide the DNxchange so that the rear mounting brackets can 
pass through the rack to the rear mounting rails and the front of the DNxchange is flush 
against the front mounting rails.

2. Align the holes in the DNxchange bezel with the rack-nut clips in the front mounting 
rails, insert the front-rack screws through the DNxchange bezel, and front-mounting 
rail, and tighten.

3. Slide the mounting brackets to the rear-mounting rail so that mounting-rail ears are on 
the outside of the rear rails.

4. Align the holes in the mounting brackets with the rack-nut clips in the rear-mounting 
rails. 

The mounting bracket is designed to bend to the rear rail.

5. Insert the rear-rack screws through the mounting brackets and rear-mounting rail, and 
tighten.

Adjusting and Securing the Mounting Brackets

a

1 of 4 front- 
rack screws

Rack enclosure 
front-mounting rail

Mounting 
bracket

1 of 4 rear- 
rack screws

Bezel
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Cabling

The following sections describe the cabling on the rear of the DNxchange:

• Power Cord

• Capture Cables

• Play Cables

• Timecode Cables

• Configuration Cables

Power Cord

A US IEC power cord is shipped with the DNxchange. If your local power distribution is not 
compatible with the supplied cord, you must provide your own IEC power cable that is 
compatible with your country’s power system. The power connector accepts 100 to 240 Vac, 
50/60 Hz.

Power Connection

To connect power:

1. Attach the power cord to the power receptacle on the rear of the DNxchange.

2. Connect the other end of the power cord to a properly grounded, stable power source. 

c For maximum power protection, Avid recommends surge protected uninterruptible 
power supply (UPS). 

OUTLTCINOUTINOUT 10/100 BASE T

SERIAL

HD SD

Power cord 
receptacle
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Capture Cables

The HD and SD SDI connections are marked on the rear of the DNxchange. Either channel 
in the DNxchange can be configured for capture or play. The following figure is shown using 
the factory default channels (left channel Capture, right channel Play). The following 
procedure states which connectors to use. To find the exact location for each connection, see 
Appendix A.

To connect video cables on the chassis:

1. Ensure that you have the proper SMPTE 259M serial digital interface coaxial cables 
available. 

Capture Connections

2. Connect a reference source to the REF input connector on the DNxchange channel. For 
more information, see “Reference Signal” on page 15.

3. Connect the incoming HD-SDI signal to the HD input connector on the DNxchange 
channel. 

4. Connect the SD OUT on the DNxchange channel to your SDTI network video switcher. 

OUTLTCINOUTINOUTINOUTINOUTIN OUTINREF REF

SERIAL

10/100 BASE T 10/100 BASE TLTC

SERIAL

HDSDHD SD

HD deck to 
HD SDI input

SD SDTI output
to SD SDTI network

Reference

(Optional) Incoming HD 
can be viewed on an HD 
monitor

Devices on the SDTI 
network and HD deck

PlayCapture
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Play Cables

The HD and SD SDI connections are marked on the rear of the DNxchange. The following 
procedure states which connector to use. To find the exact location for each connection, see 
Appendix A.

To connect video cables on the chassis:

1. Ensure that you have the proper SMPTE 259M serial digital interface coaxial cables 
available. 

Play Connections

2. Connect a reference source to the REF input connector on the DNxchange channel. For 
more information, see “Reference Signal” on page 15.

3. Connect the SD-SDTI signal from your SDTI network to the SD IN connector on the 
DNxchange channel. 

4. Connect the HD OUT on the DNxchange channel to your HD deck. 

OUTLTCINOUTINOUTINOUTINOUTIN OUTINREF REF

SERIAL

10/100 BASE T 10/100 BASE TLTC

SERIAL

HDSDHD SD

SD SDTI input
from SD SDTI network

Devices on the SDTI 
network and HD deck

Reference

HD output to HD deck 
or HD monitor

PlayCapture
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Timecode Cables

To connect longitudinal timecode (LTC) cables:

1. Connect your LTC timecode source to the LTC IN connector.

2. Connect the LTC OUT connector to your LTC timecode device.

LTC Connection

Configuration Cables

The following figure identifies the connectors used to connect the configure the DNxchange 
channels. 

Configuration Connections

Ethernet Connection

Make the following connection when configuring a DNxchange channel through the 
Ethernet port.

n If connecting a computer directly to the DNxchange Ethernet port, a Ethernet cross-over 
cable is required.

OUTLTCINOUTINOUTINOUTINOUTIN OUTINREF REF

SERIAL

10/100 BASE T 10/100 BASE TLTC

SERIAL

HDSDHD SD

LTC out

LTC in

PlayCapture
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connection

RS-232 serial 
connection
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To connect Ethernet cables:

1. Connect one end of an Ethernet CAT-5 cable to the 10/100BASE-T connector on one of 
the DNxchange channels. 

2. Connect the other end of an Ethernet cable to your network switch. 

3. Access the user configuration windows using a browser application. See “User 
Configuration Windows” on page 36.

Serial Connection

Make the following connection when configuring a DNxchange through through the serial 
port.

n If connecting a computer directly to the DNxchange serial port, a serial cross-over cable is 
required.

To connect serial cables:

1. Connect one end of a 9-pin serial cable to the RS-232 connector on the DNxchange 
channel. 

2. Connect the other end of the serial cable to your RS-232 device.

3. Access the configuration menu using the HyperTerminal application. See “Accessing 
the DNxchange Through HyperTerminal” on page 43.

Updating the Firmware

Typically new units are shipped with the latest code loaded on each DNxchange channel. If 
you are instructed to download a new version of the firmware, this section describes the 
Avid DNxchange Firmware Updater utility included on the CD-ROM that ships with the 
DNxchange. 

The DNxchange upgrade process requires multiple firmware files to be located in a single 
folder on a Windows® computer. The computer performing the upgrade must be on the same 
network subnet as the DNxchange channel. The update utility performs the following 
functions:

• Locates all the DNxchange channels connected to the same subnet as the computer 
running the utility

• Uploads all the firmware files to the selected DNxchange channel and writes it into flash 
memory

• Restarts the selected DNxchange channel
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Double-click on the executable file and follow the on-screen instructions to install the utility 
on your network computer. The utility installs in the following default location:

C:\Program Files\Avid DNxchange Channel FW Updater

To update a DNxchange channel:

1. Create a new folder and copy the new firmware files into a single folder on the computer 
performing the upgrade.

2. Make sure your computer is connected to same network subnet as your DNxchange.

3. Click Start > Programs > Avid DNxchange FW Updater > Avid DNxchange FW 
Updater. If you browse to the folder using Windows Explorer, double-click the Avid 
DNxchange FW Updater.exe file.

The Avid DNxchange Channel Firmware Updater searches the network and lists the 
DNxchange channels detected on the same network subnet. The DNxchange Channel 
Firmware Updater dialog box opens, followed by the Select DNxchange Channel IP 
Address dialog box.

n To find your DNxchange channel IP address, connect the computer’s serial port to the serial 
connector on each DNxchange channel. At the serial configuration menu, go to Network 
Settings and note each IP address. For information on using the serial port, see “Accessing 
the DNxchange Through HyperTerminal” on page 43.
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4. Select the DNxchange channel you want to upgrade from the menu and click OK. Click 
Cancel to close this dialog box and quit the utility. 

The Select DNxchange IP Address dialog box appears.

5. Do one of the following:

t Click “Yes, that is correct” to accept the IP address for the DNxchange channel 
selected and continue with the upgrade.

t Click “No, I’ll try again” to return to the Select DNxchange channel IP Address 
dialog box and select a different IP address and DNxchange channel. 

t Click “No, cancel and quit” to close this dialog box and quit the utility.
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6. If you clicked “Yes, that is correct,” browse to the folder where you copied the new 
firmware on your computer.

c Make sure the firmware folder does not include any files other than the files included in 
the current upgrade or any files from a previous upgrades. Create a new folder for 
each upgrade. 
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7. Click Select Cur Dir to start the upgrade.

c Do not interrupt the upgrade or restart the DNxchange until the utility has finished.

Progress bars are displayed as each firmware file is updated.

The DNxchange channel automatically loads the new code and a dialog box informs 
you when the process is complete.

8. Click OK to quit the utility.

9. Repeat this procedure for each DNxchange channel that needs upgrading.

If you have two DNxchange channels in your DNxchange, you must upgrade both 
channels in the DNxchange.
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Monitoring Frame Input Errors

The DNxchange_BER_Tool is a utility used to monitor the bit error rate on the SD SDTI 
input of the DNxchange channel in Play mode. This utility is included on the CD-ROM that 
ships with the DNxchange. 

The DNxchange_BER_Tool utility is used on a Windows® computer connected to the same 
network subnet as the DNxchange channel. The utility performs the following functions:

• Locates all the DNxchange channels connected to the same subnet as the computer 
running the utility

• Records the number of frames polled and errors detected

• Displays the amount of time the utility has been monitoring the media

n An HD SDI Output on Error setting is provided in the DNxchange UI that enables you to 
select what to output on the HD Out connector when three or more consecutive frames 
errors are detected in Play mode. You can either repeat the last good frame or output black 
frames to the HD Out connector. To more information on this setting, see “I/O Settings Tab” 
on page 39.

The bit error rate (BER) is displayed in scientific notation based on the number of frames 
polled and the errors found. A reset button is available in the utility to clear the fields and 
start monitoring the frames again. If errors are displayed, first run the 
DNxchange_BER_Tool utility on a different channel using the same cables. If errors 
continue to be detected, check your cable integrity, cable connections, and cable lengths. 

To install the utility:

1. Copy the DNxchange_BER_Tool folder to your computer.

2. Double-click Setup.exe in the utility folder and follow the on-screen instructions. The 
utility installs in the following default location:

C:\Program Files\DNxchange_BER_Tool

n Use the Windows Control Panel to uninstall the DNxchange_BER_Tool. Avid Recommends 
uninstalling the DNxchange_BER_Tool before installing a later version.

To monitor a DNxchange channel:

1. Load the DNxchange_BER_Tool utility on a Windows computer.

2. Make sure your computer is connected to same network subnet as your DNxchange.
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3. Click Start > Programs > DNxchange_BER_Tool > DNxchange_BER_Tool. If you 
browse to the folder using Windows Explorer, double-click DNxchange_BER_Tool.exe.

The DNxchange_BER_Tool searches the network and lists the DNxchange channels 
detected on the same network subnet. The following dialog box opens.

4. Select the DNxchange channel IP address from the menu that you want to monitor and 
click OK.

n To find your DNxchange channel IP address, connect the computer’s serial port to the serial 
connector on each DNxchange channel. At the serial configuration menu, go to Network 
Settings and note each IP address. For information on using the serial port, see “Accessing 
the DNxchange Through HyperTerminal” on page 43.

The DNxchange_BER_Tool window opens. Information describing the window follows 
the figure.

DNxchange_BER_Tool Selections  

Button or Field Description

IP Address The IP address of the DNxchange channel that was selected is 
displayed in this text box.

Connected This light indicator is lit when a valid connection exists between 
the utility and the DNxchange channel.
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To close the DNxchange_BER_Tool, do one of the following:

t Click the close button at the top right-hand corner of the window.

t Click Stop.

Polling The light indicator flashes each time media is monitored. 
Frames are monitored approximately every 3 seconds.

Stop Click the Stop button to stop monitoring frames. The utility 
stops and closes.

Start/Reset Counters button Click the Start/Reset Counters button to clear the Time elapsed, 
BER, Total Frame Count, and Bad Frame Count text fields and 
restart the monitoring.

Time elapsed since counter reset Displays the amount of time that has passed since you started 
monitoring for errors or have last clicked the Start/Reset 
Counters.

Format The HD format that is currently set on the DNxchange channel 
is displayed in the Format text box.

1080i 50.00 (25.00)
1080i 59.94 (29.97)
720p 59.94

BER (frame errors/bits transferred) Displays the percentage of bit errors detected compared to the 
number of frames polled. The number displayed is in scientific 
notation.

Total Frame Count Displays the number of frames that were polled (monitored) 
since the counter was last reset.

Bad Frame Count Displays the number of bad frames detected since the counter 
was last reset.

DNxchange_BER_Tool Selections (Continued)  

Button or Field Description
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Chapter 3

Configuration

This chapter describes how to configure the DNxchange through the user interface (UI). 

n You might want to configure the DNxchange prior to rack mounting if the front panel access 
is limited in your rack location.

c Do not connect multiple DNxchange channels to your network environment until you 
have assigned a new unique IP address to each DNxchange channel. 

Power Up, Power Down
To power up the DNxchange:

t Press the DNxchange power button, located on the front panel. 

The LED ring around the power button lights amber as the DNxchange is powering up 
and turns green when the DNxchange has completed its startup and is ready. 

Power Switch

a
Power button LED ring
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User Configuration Windows

The user interface allows you to set the network configuration and video format parameters. 
All network communication is done through the Ethernet connection on the rear of 
DNxchange. Each DNxchange channel needs to be configured separately. As an alternative, 
you can use HyperTerminal through your serial connector to configure the DNxchange. For 
more information, see “Accessing the DNxchange Through HyperTerminal” on page 43.

To access the DNxchange configuration windows with your browser:

1. Open your browser application and type in the IP address of your DNxchange channel 
in the Address text box and press Enter.

The Connect to dialog box opens.

Client Password Dialog Box

2. Click OK. 

The default shipping configuration does not use a User’s Name or Password. Only type 
a Password if you have set one using the serial connection. To set a Password, see 
“Accessing the DNxchange Through HyperTerminal” on page 43. 

n The User Name is always blank and cannot be changed.
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Default IP Address

Each DNxchange channel in the DNxchange is initially configured with the following 
default IP address and Subnet mask: 

• Play IP address: 192.168.1.101

• Capture IP address: 192.168.1.102

• Subnet mask: 255.255.255.0

n The default Play channel and Capture channel settings do not need to remain set as shipped 
from Avid. Either or both channels can be set to Play or Capture.

DNxchange Channel Default Dual-Channel Configuration

n When accessing a DNxchange channel through a browser interface via Ethernet and that 
DNxchange channel has been removed, the browser application might attempt to connect to 
a similar IP address before displaying a “Page Not Found” message. Be sure to verify the 
IP address displayed is the channel to which you want to connect.

To avoid network IP address and subnet mask conflicts, connect one DNxchange to your 
network at a time. Set the appropriate IP address and subnet mask settings in the Network 
Setting tab for that DNxchange and save the settings. For information on the Network tab, 
see “Network Setting Tab” on page 41. The IP address and subnet mask information must 
be provided to you by your network administrator.

OUTLTCINOUTINOUTINOUTINOUTIN OUTINREF REF

SERIAL

10/100 BASE T 10/100 BASE TLTC

SERIAL

HDSDHD SD

Factory default play channelFactory default capture channel

This channel is empty in a 
single-channel configuration
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General Tab

The General tab is used to display the current video settings and status of the DNxchange 
channel through the network. The information displayed on this tab is either embedded in 
the channel or is selected in the other tabs of this UI. The following figure shows an example 
of the General tab. 

General Tab
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I/O Settings Tab

The I/O Settings tab allows you to select the HD format you want to transcode. 

I/O Settings Tab

You are required to provide the following input and output information:

• HD Format — This setting is used to select the HD media format being encoded or 
decoded.

- 1080 Interlaced — 1080i/50.00 fields per second

- 1080 Interlaced — 1080i/59.94 fields per second

- 720 Progressive — 720p/59.94 frames per second

• HD I/O Mode — Use this setting to select how the media is passing through the 
DNxchange channel: 

- Capture — HD to SD (compression/encoder) 

- Play — SD to HD (decompression/decoder)

Submit 
button
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• HD Genlock Ref— Select the type of sync signal connected to the REF connector on the 
rear of the DNxchange channel. 

- Black Burst — select if house reference is NTSC/PAL

- Internal — uses an internal clock for loopback and standalone testing

- Tri-Level — select if house reference is an HD reference source

• HD SDI Output on Error — Use this setting to select what to output on the HD Out 
connector if an error is detected on three or more consecutive frames of media passing 
through the DNxchange channel in Play: 

- Repeat — Repeats the last good frame to the HD Out connector when errors are 
detected

- Black — Outputs black frames on the HD Out connector when errors are detected

• Output Timing Adjustment — Locks the video output signal timing to the analog 
reference input signal provided to the rear panel connector.

Allows you to slow down or advance the video timing in μsecs (microseconds) relative 
to the horizontal genlock timing source.

Type a “–” (minus sign) in front of the number to slow down the timing and type a “+” 
(plus sign) in front of the number to speed up the timing. 

Click Submit to save your configuration. The DNxchange requires a restart to enable the 
video changes.
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Network Setting Tab

The Network Settings tab allows you enter the network parameters.

Network Settings Tab

n Any changes you make to the current network settings will not take effect until you click the 
Submit button and then restart the DNxchange. 

n If you are unsure about any network configurations, names, or setup values discussed below, 
please contact your facility’s administrator for technical assistance.

You are required to provide the following network information:

• Host Name — Type the network name you want to give the DNxchange channel. Only 
alpha and numeric characters can be used for the Host Name; no other characters are 
valid.

• IP Lookup — Select Static or Dynamic from the menu. Select Dynamic if you want the 
network to provide you with an IP address. Select Static if you want enter an IP address. 

• IP Address — Enter the IP address you want to assign to the DNxchange channel. Only 
enter an IP address if you selected Static in the IP Lookup.

• Subnet Mask — Enter the your subnet mask address.

Submit 
button
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• Gateway — Enter the address for your network’s default gateway (option).

• MAC Address — Displays the Machine Access Control (MAC) address for the 
DNxchange channel. This information cannot be changed.

Click Submit to save your configuration and enable the network interface. After the network 
is configured, restart the DNxchange to enable the settings.

Ancillary Data Settings Tab

The Ancillary Data Settings tab allows you to select the HD format you want to transcode. 

Ancillary Data Settings Tab

To enable SD and HD closed captioning support use the following settings:

• HD Closed Captioning (CEA 708) — Use this setting to enable support of CEA 708 
closed captioning auxiliary data. When enabled, closed capturing ancillary data packets 
are captured from the HD-SDI source according to the SMPTE 334M standard.

• SD Closed Captioning (CEA 608) — Use this setting to enable support of CEA 608 
closed captioning auxiliary data. When enabled, closed capturing ancillary data packets 
are captured from the HD-SDI source according to the SMPTE 334M standard. 

Submit 
button
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• Program Description (DTV) — Use this setting to enable support of digital television 
program description auxiliary data. When enabled, DTV ancillary data packets are 
captured from the HD-SDI source according to the SMPTE 334M standard. 

• Ancillary Time Code — Use this setting to enable support of ATC auxiliary data. When 
enabled, ancillary time code packets are captured from the HD-SDI source.

Click Submit to save your configuration. The DNxchange requires a restart to enable the 
video changes.

Accessing the DNxchange Through HyperTerminal

You can access the DNxchange configuration settings using HyperTerminal through the 
serial connector. You need to know the following serial protocol:

• Baud Rate — 19200

• Data Bits — 8

• Parity — None

• Stop Bits — 1

• Flow Control — None

To access your DNxchange using HyperTerminal:

1. Make sure your DNxchange is powered on.

2. Connect the serial COM port on your computer to the serial connector on the 
DNxchange channel.

3. From a Windows system, click Start > Programs > Accessories > Communications > 
HyperTerminal.
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4. Type a name for the connection, select the COM port, and configure the connection 
using the serial protocol previously listed.

The following figure is an example of the Main Menu that displays in the 
HyperTerminal window. Each DNxchange channel is configured using the serial 
connection on that channel.

Main Menu Options Using HyperTerminal

To select a Main Menu option:

t Type a number listed in the option list and press Enter.
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Changing or Resetting the Password 

When you change the default or the existing password, the password cannot exceed 31 
characters. The Password is case sensitive and the User Name is always blank and cannot be 
changed.

To set or change the password:

1. Access the DNxchange using the serial port, see “Accessing the DNxchange Through 
HyperTerminal” on page 43.

Main Menu Options
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2. Type 7 to select the Password. 

3. Press Enter.

Password Config Menu Options

4. Do one of the following:

t Type 1 to Modify Password.

t Type 2 to Reset Password to the factory default (no user name and password).

5. Press Enter.
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6. Type 3 to Save Changes.

Allow the DNxchange channel to save the changes and display the “Password 
successful updated” message.

Password Successfully Updated

7. Do one of the following:

t Type 9 to return to the Main Menu.

t Click File > Exit to exit HyperTerminal.

Diagnostic Tests
The input and output circuitry of each connector on the DNxchange channel can be tested 
using the HyperTerminal application through a serial connection. The serial configuration 
menu provides a Diagnostics option in the menu. The diagnostic tests require loopback 
cables on the following DNxchange channel connectors:

• HD IN to HD OUT

• SD IN to SD OUT

• LTC IN to LTC OUT

The DNxchange diagnostics include a test that detects a valid genlock signal when a 
reference signal is connected to the REF connector. 

n Do not run the diagnostics unless requested by Avid Customer Support. 
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Network Test

You can ping the Avid DNxchange to see if the Avid DNxchange is seen by the network. To 
verify communication from a client system (such as a NewsCutter) which is on the Avid 
Unity network, obtain the IP address of the target DNxchange.

To ping DNxchange from a client system on the Avid Unity network:

1. Click Start > Run.

2. Type the ping command and the IP address of your channel in the DNxchange. For 
example:

ping 192.168.1.101

A command prompt window will open and display the ping command and a response, if 
the Avid DNxchange is seen by the network.

If the ping succeeds, a series of responses appears, for example: 

8 packets transmitted, 8 packets received, 0% packet loss

3. Close the command prompt window when done.
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Channel Test

You can test two DNxchange channels by providing an HD signal into one channel and 
connecting the SD output of that channel to the SD input of a second channel. Connect an 
HD monitor to the HD output of that second channel. The HD output of the second channel 
should match the HD input of the first channel. 

n You must provide a reference signal to both channels and make sure the appropriate 
channels are configured for capturing or playing out.

End-to-End Channel Loop Test

The HD media from the output of the second channel output is delayed because of internal 
encoding and decoding taking place in both channels. 

To complete the test, reconnect the two channels using the second channel as the HD input 
and the first channel as the HD output. This test can also be performed using two single-
channel DNxchange enclosures. 

After connecting an HD SDI signal to the HD In on the capture channel, verify that the 
HD SDI Input signal is detected by looking at the System Status on the General tab in the 
DNxchange UI, see “General Tab” on page 38. Check that the SD SDI Input is detected on 
the Play channel.

You can view media being captured on the HD In connector by connecting an HD monitor to 
the HD Out connector when the DNxchange channel is in Capture mode. For more 
information on viewing the media while capturing, see “Monitoring HD Video During 
Capture” on page 16.

OUTLTCINOUTINOUTINOUTINOUTIN OUTINREF REF

SERIAL

10/100 BASE T 10/100 BASE TLTC

SERIAL

HDSDHD SD

DNxchange channel in 
Capture mode

SD SDTI

HD SDI

DNxchange channel in 
Play mode

HD monitor

HD SDI

HD deck

Reference 
signal
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Chapter 4

Installing the Optional Second 
DNxchange Channel

This chapter describes how to install the second DNxchange channel if you have purchased 
an Avid DNxchange with a single channel installed. The optional DNxchange channel is 
initially configured with the following default IP address and Subnet mask: 

• IP address: 192.168.1.101

• Subnet mask: 255.255.255.0

The following is a list of required tools for installing the second channel in the DNxchange:

• Phillips screwdriver

• Anti-static ground strap

• 9/16 extended length nut driver

• 3/16 nut driver

If your DNxchange transcoder is rack mounted, turn off the transcoder, disconnect all cables 
connected to the transcoder, and remove the transcoder from the rack. 

To install a second DNxchange channel:

1. Disconnect the ac power cord and any other cables from the rear of the DNxchange 
enclosure.

2. Put on an antistatic wrist strap and connect it to a metal ground point on the DNxchange.

c To avoid static damage to your circuit board, take the proper antistatic precautions 
before handling the board.
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3. Remove the 23 top cover screws.

Top Cover Screws

4. Remove the four blank panel screws on the rear of the DNxchange and remove the blank 
panel from the inside of the chassis.

Blank Panel Screws

5. Locate the five spacers included in the option kit and place a spacer on each BNC 
connector on the new DNxchange channel (see “BNC Spacers, Lock Washers, and 
Nuts” on page 54.)

a

1 of 23 top cover screws

OUT

REF

IN
LTC

SERIAL

OUT

IN HD SDI

OUT

IN SD SDI

Blank panel screws

Blank panel (inside)
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6. Position the new DNxchange channel board such that the connectors are aligned with 
the holes in the rear panel of the DNxchange and slide the board toward the rear so that 
the connectors extend through the appropriate holes.

Positioning the Optional DNxchange Channel

OUT

LTC

OUT

IN

OUT

IN

OUT

IN

OUT

IN

Second DNxchange 
channel
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7. Secure the new DNxchange channel board to the DNxchange chassis with eight screws.

Second DNxchange Channel Screws

8. Locate the BNC lock washers and nuts included in the option kit and place a washer 
then a nut on each BNC connector.

BNC Spacers, Lock Washers, and Nuts

1 of 8 board 
screws 

O U T

R E F

IN
LT C

S E R IA L

O U T

IN
H D  S D I

O U T

IN
S D  S D I

BNC connector

Spacer

Lock washer

BNC nut

The BNC nut has two slots 
in the threads that allow the 
nut to slip over the two posts 
in the BNC connectors.
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9. Use a 9/16 extended-length nut driver to tighten the nuts on the BNC connectors.

10. Insert the serial connector with attached cable into the D-shaped hole in the rear panel 
from the inside of the chassis.

11. Secure the serial connector using the hex-nut screws and 3/16 nut driver.

12. Connect the serial ribbon cable to the serial connector near the rear of the DNxchange 
channel. 

Serial and XLR Connectors

13. Locate the four self-tapping screws and secure the XLR connectors to the rear of the 
DNxchange.

c Do not over tighten the self-tapping screws into plastic XLR connectors.

14. Connect the two fan cables to the fan connectors near the front of the DNxchange 
channel board.

O U T

IN

O U T

IN

Serial ribbon 
cable connector

XLR connectors

Serial hex-nut 
screws
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15. Connect the power extension cable between the two DNxchange channels boards.

Internal Cables

16. Replace the DNxchange top cover and 23 screws.

c Do not connect the power or attempt to turn on the DNxchange without replacing the 
top cover on and screws.

OUT

LTC

OUT

IN

OUT

IN

OUT

IN

OUT

IN

Fan connectors

Power extension 
cable
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Connections

This appendix explains each connector on the rear of the Avid DNxchange. The figures 
shows the Avid DNxchange with two channels installed in each unit. The dotted line in the 
figure indicates the separation between the two channels. 

The initial configuration is done using the Ethernet port connectors on the rear of the 
DNxchange. The Ethernet connectors are identified in the “Control Connections” on 
page 58. Each DNxchange channel must be configured separately. You do not need to 
connect your SDI inputs and outputs when configuring the channels.

c The each DNxchange channel within the DNxchange enclosure ships with a default IP 
and subnet address (see “Default IP Address” on page 37). Do not connect more than 
one DNxchange enclosure to your network environment until you have initially 
configured each channel in the DNxchange with a unique IP address provided by your 
network administrator.
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Control Connections

The following figure identifies the serial and network connectors on the DNxchange. For a 
description of each connector, see the following table.

Serial and Ethernet Interface Connectors

OUTLTCINOUTINOUTINOUTINOUTIN OUTINREF REF

SERIAL

10/100 BASE T 10/100 BASE TLTC

SERIAL

HDSDHD SD

1

2

1

2

DNxchange Serial and Ethernet Identifiers  

Number Label Function

1 10/100 BASE-T
(Ethernet control interface)

10/100BASE-T port Ethernet connection provides a 
configuration connection using a browser application. Use a 
cross-coupled Ethernet cable when connecting to a local 
computer. 

DNxchange uses this port to configure each channel through a 
browser interface.

2 SERIAL
(serial interface)

9-pin female RS-232 serial interface used for configuring the 
DNxchange.
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Reference and LTC Connections

The following figure identifies the reference sync and LTC connectors on the DNxchange. 
For a description of each connector, see the following table.

Reference and LTC Connectors

OUTLTCINOUTINOUTINOUTINOUTIN OUTINREF REF

SERIAL

10/100 BASE T 10/100 BASE TLTC

SERIAL

HDSDHD SD

2 31 2 3 1

Reference and LTC Identifiers  

Number Label Function

1 REF (reference input) Video reference (REF) input for a black-burst generator or 
tri-level sync with phase lock to black-burst signal, BNC 
connector. 

2 LTC IN Longitudinal timecode input, female connector. Provides a feed to 
the DNxchange server for an analog timecode signal, allowing an 
alternate source generated timecode to be applied to the captured 
material. 

3 LTC OUT Longitudinal timecode output, male connector. Analog timecode 
signal that can be used by external devices that require such a 
signal for their capture or command and control operations.
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Standard and High Definition Connections

The following figure identifies the standard definition (SD) and high definition (HD) serial 
digital interface (SDI) connectors on the DNxchange. For a description of each connector, 
see the following table.

SDI Connectors

OUTLTCINOUTINOUTINOUTINOUTIN OUTINREF REF

SERIAL

10/100 BASE T 10/100 BASE TLTC

SERIAL

HDSDHD SD

1 2 3 4 1 2 3 4

SDI Identifiers  

Number Label Function

1 HD IN High Definition Serial Digital Interface input, BNC connector.

2 HD OUT High Definition Serial Digital Interface output, BNC connector.

3 SD IN Standard Definition Serial Digital Transport Interface input, 
BNC connector.

4 SD OUT Standard Definition Serial Digital Transport Interface output, 
BNC connector.
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Specifications

This appendix provides a detailed listing of the following technical system specifications:

• Physical Specifications

• Audio Specifications

• Video Specifications

• Control and Synchronization Specifications

• Data Specifications

• Rear Panel Specifications

n All specifications are subject to change without notice.

Physical Specifications
Physical Specifications  

Parameter Specification

Dimensions inches: 19.00 (w) x 1.75 (h) x 24.9 (d)
cm: 48.3 (w) x 4.4 (h) x 63.3 (d) 

Rack Units 1

Weight pounds: 20 
kilograms: 9.07 

Power and Environment Requirements  

Parameter Specification

Power 100 to 240 Vac, 50/60 Hz Auto Ranging, 150 Watts

Environmental 10°C to 35°C, 90% RH non-condensing
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Audio Specifications

Video Specifications

Control and Synchronization Specifications

Audio Specifications  

Parameter Specification

Audio Channels 8 audio channels per SDI input
embedded audio

Sampling 48 KHz, 24 bit precision, Balanced Differential

AC-3 Fully compatible with professional and consumer encoding

Video Specifications  

Parameter Specification

Video Channels 1 Receive or 1 Play Channel 
SD SDTI SMPTE - 259M
HD SDI SMPTE - 292

1 SD SDTI input, 
1 SD SDTI output

ITU-R BT.-601 10-bit Serial Digital 
Component Video

1 HD SDI input, 
1 HD SDI output

ITU-R BT.-601 10-bit Serial Digital 
The HD OUT can be used for monitoring video during capture.

Control and Synchronization Specifications  

Parameter Specification

External Control RS-232 control configuration and diagnostics 

Timecode Linear Timecode SMPTE 12M Balanced I/O

Vertical Interval Timecode, SMPTE 266 Compatible with Input and 
Output Line Selections

Reference HD sync signal input
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Data Specifications

Rear Panel Specifications

Output timing 5 lines advance to 3 lines delay in 1/8th pixel steps

Internal Time Derived from VITC on composite reference input

Latency 6 frames per channel

Data Specifications  

Parameter Specification

Ethernet Port RJ-45 connector, 10BASE-T or 100BASE-T, auto sensing 

Rear Panel Specifications  

Parameter Specification

Serial 9-Pin female D connector, RS-232

LTC Timecode IN: 1 XLR female connector
OUT: 1 XLR male connector

HD SDI IN: 1 BNC connector
OUT: 1 BNC connector

SD SDTI IN: 1 BNC connector
OUT: 1 BNC connector

Reference IN: 1 BNC connector

Control and Synchronization Specifications (Continued)  

Parameter Specification
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Appendix C

Regulatory and Safety Notices

Warnings and Cautions

w Never install equipment if it appears damaged. 

w Disconnect the power cord before servicing unit. 

w Only perform the services explicitly described in this document. For services or 
procedures not outlined in this document, speak with authorized Avid service 
personnel. 

c Follow all warnings and cautions in the procedures. 

c Operate the device within its marked electrical ratings and product usage instructions.

FCC Notice

This device complies with Part 15 of the FCC Rules. Operation is subject to the following 
two conditions:

1. This device may not cause harmful interference.

2. This device must accept any interference received, including interference that may cause 
undesired operation.

This equipment has been tested and found to comply with the limits for a Class A digital 
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide 
reasonable protection against harmful interference when the equipment is operated in a 
commercial environment. This equipment generates, uses, and can radiate radio frequency 
energy and, if not installed in accordance with the instruction manual, may cause harmful 
interference to radio communications. Operation of this equipment in a residential area is 
likely to cause harmful interference in which case the user will be required to correct the 
interference at his own expense. 
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Canadian ICES-003

This Class A digital apparatus meets all requirements of the Canadian Interference Causing 
Equipment Regulations.

Cet appareil numérique de la classe A respecte toutes les exigences du Règlement sur le 
matériel brouilleur du Canada.

European Union Notice

Declaration of Conformity 
(According to ISO/IEC Guide 22 and EN 45014)

Application of Council 
Directives: 

73/23/EEC, 89/336/EEC. 

Standards to which 
Conformity is Declared: 

EN60950:1999 Third Edition
CISPR 22:1997 / EN55022:1994 + A1:1995 + A2:1997 Class A 
EN55024:1998/EN61000 — 3-2, 4-2, 4-3, 4-4, 4-5, 4-6, 4-11

Manufacturer’s Name: Avid Technology, Inc. 
1925 Andover Street
Tewksbury, MA 01876, USA

European Contact: Nearest Avid Sales and Service Office or 
Avid Technology International B.V. 
Sandyford Business Center 
Unit 3,
Dublin 18, Ireland

Type of Equipment: Information Technology Equipment
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(1) Products for the Windows NT, Windows 2000, or Windows XP Operating System: products were 
tested in a typical Avid Adrenaline DNA, Avid DS Nitris DNA, Avid Equinox Break-Out-Box, 
Avid|DS, Avid Xpress, Avid Xpress DV, Film Composer, Media Composer, MediaDock, MediaDock 
2+, MediaDrive, MediaRAID, MEDIArray, MEDIArray Drive, MEDIArray II, MEDIArray II Drive, 
Meridien I/O box, NewsCutter, NewsCutter DV, NewsCutter XP, Pro Tools AVoption|V10, or 
Symphony configuration.

(2) Products for the Mac OS X Operating System: products were tested in a typical Avid Adrenaline 
DNA, Avid Xpress, Avid Xpress DV, Film Composer, Media Composer, MediaDock, MediaDock 2+, 
MediaDrive, MediaRAID, MEDIArray, MEDIArray Drive, MEDIArray II, MEDIArray II Drive, 
Meridien I/O box, Pro Tools AVoption|V10, or Symphony configuration.

(3) Products for the UNIX Operating System: products were tested in an AirPlay, AirSpeed, 
DNxchange, or VideoSPACE configuration.

(4) Products for MediaNetwork and Workgroups: products were tested in a typical Avid ProEncode, 
Avid Unity ISIS, Avid Unity MediaManager, Avid Unity MediaNetwork (includes File Manager), 
Avid Unity TransferManager, LANserver, LANserver EX, MEDIArray, MEDIArray Drive, 
MEDIArray II, MEDIArray II Drive, MEDIArray ZX, MEDIArray ZX Drive, Nearchive, PortServer, 
or Xdeck configuration.

Product Name: Products for the Windows NT, Windows 2000, or Windows XP Operating 
System: Avid Adrenaline DNA, Avid DS Nitris DNA, Avid Equinox 
Break-Out-Box, Avid|DS, Avid Xpress, Avid Xpress DV, Film Composer, 
Media Composer, MediaDock, MediaDock 2+, MediaDrive, MediaRAID, 
MEDIArray, MEDIArray Drive, MEDIArray II, MEDIArray II Drive, 
Meridien I/O box, NewsCutter, NewsCutter DV, NewsCutter XP, 
Pro Tools AVoption|V10, Symphony

Products for the Mac OS X Operating System: Avid Adrenaline DNA, 
Avid Xpress, Avid Xpress DV, Film Composer, Media Composer, 
MediaDock, MediaDock 2+, MediaDrive, MediaRAID, MEDIArray, 
MEDIArray Drive, MEDIArray II, MEDIArray II Drive, Meridien I/O 
box, Pro Tools AVoption|V10, Symphony

Products for the UNIX Operating System: AirPlay, AirSPACE, AirSpeed, 
DNxchange, VideoSPACE

Products for MediaNetwork and Workgroups: Avid ProEncode, 
Avid Unity ISIS, Avid Unity MediaManager, Avid Unity MediaNetwork 
(includes File Manager), Avid Unity TransferManager, LANserver, 
LANserver EX, MEDIArray, MEDIArray Drive, MEDIArray II, 
MEDIArray II Drive, MEDIArray ZX, MEDIArray ZX Drive, Nearchive, 
PortServer, Vixel switches (8100, 7100, 7200, 9100, 9200), Xdeck

Base Model Numbers: None

Product Options: All

Year of Manufacture: 2006



 Appendix C Regulatory and Safety Notices

68

I, the undersigned, hereby declare that the equipment specified above conforms to the above 
Directives and Standards.

George R. Smith, Director of Hardware Engineering

Disposal of Waste Equipment by Users in the 
European Union

This symbol on the product or its packaging indicates that this product must not be disposed 
of with other waste. Instead, it is your responsibility to dispose of your waste equipment by 
handing it over to a designated collection point for the recycling of waste electrical and 
electronic equipment. The separate collection and recycling of your waste equipment at the 
time of disposal will help conserve natural resources and ensure that it is recycled in a 
manner that protects human health and the environment. For more information about where 
you can drop off your waste equipment for recycling, please contact your local city recycling 
office or the dealer from whom you purchased the product.

Australia and New Zealand EMC Regulations

John Kells, Australian Operations Manager
Avid Technology (Australia)
Unit B
5 Skyline Place
French Forest NSW 2086
Australia
Phone: 61-2-8977-4800

Taiwan EMC Regulations
Taiwan EMC Regulations BSMI Class A EMC Warning
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D
Data
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Decoder
play mode 11
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Decompression
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M
MAC (machine access control) address 42
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Monitoring media 16
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